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This booklet explains differences between the GP2000/77R series and the

GP3000/ST3000 series and how to change the settings.  
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1. Touch Panel Type 

 

The touch panel type of the GP3000 series differs from that of the GP2000 series. The GP2000 

series uses the matrix type, on the other hand, the GP3000 series uses the analog touch panel 

type, which offers you flexibility of switch positioning because there is no grid.   

                   

The major differences of touch panel operation between the GP3000 series and the GP2000 

series are as follows;  
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Difference 1 

The GP3000 series doesn’t support the two-point nor three-point touch, which the GP2000 

series supports.  

 

 

Therefore, the switch operation with the two-point touch on the GP2000 series cannot perform 

on the GP3000 series. Only the first touch is enabled and the second is not recognized.  

To replace with the GP3000 series, change it to the time delay operation of the [Switch/Lamp] 

part such as ON Delay or OFF Delay feature.  

 
 



Make the settings on one of the switches for the two-point touch operation; the [Switch/Lamp] 

settings -> [Switch Common] tab -> [Delay Feature].  

 
 

Difference 2 

Using the analog touch panel type, you may need calibration of the touch position. For the 

information on how to calibrate, refer to the Maintenance/Troubleshooting Manual.  
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2. Compatibility of Bit Switch 

 

GP-PRO/PBIII's [Bit Switch] part is converted to GP-Pro EX's [Switch/Lamp] part -[Switch 

Feature].  

Basically, the operation of GP-Pro EX's [Switch/Lamp] part is the same as that of 

GP-PRO/PBIII's [Bit Switch] part, however, they may differ depending on the contents set in 

GP-PRO/PBIII. 

The setting condition by which the operation differs is introduced below. Please make changes 

referring it. 

 

Setting before conversion 

In GP-PRO/PBIII, when [Monitor] of 

[SW_NO_BORDER] (a switch part 

with no border) from the browser of 

[Bit Switch] (parts) is checked,  
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Setting after conversion 

After conversion to GP-Pro EX, [No 

Shape] in [Switch/Lamp](parts) will 

not be checked. 

 



In order to enable Monitor in GP-Pro EX in the same way as GP-PRO/PBIII, change the [Lamp 

eature] settings of [Switch/Lamp] (parts) as follows.  

ettings window and select [Lamp Feature] tab 

he field for [Bit Address] will appear. Enter the address to be monitored.  

 

F

 

Open the [Switch/Lamp] s

Check [Lamp Feature].  

T

 
 

Click [Select Shape], and you can select a shape for the lamp. 

In the “Select State Window”, set the State 0 to [SW

States 1 to [SW_SP221_ON] and then click [OK].  

H

_SP221_OFF] of the Standard Parts and the 

ere, the State 0 indicates OFF and the States 1 indicates ON.  

 

  6/45 

 

 



Next, select the [Color] tab.  

Set the [Select State] to OFF and select the [Display Color] same as the background color of the 

base screen.   

 

 
 

Click [OK] to finish the settings.  
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Changing the [Switch/Lamp] settings as above allows the switch to perform as same as one of 

the GP-PRO/PBIII’s switch with no border.  



3. Compatibility of Trend Graph 

 

GP-PRO/PBIII’s [Trend] screen is converted to GP-Pro EX’s [Historical Trend Graph] part and 

[Sampling Settings], or [Data Block Display] part. You can use them in the same way as before 

conversion.  

 

If the [Graph Type] of the [Trend] screen is set to “Normal” or “Pen Recorder”, it will be converted 

to the [Historical Trend Graph] part and the [Sampling Settings]. If “Block Display”, it will be 

converted to [Data Block Display Graph]. They will be automatically placed on each vacant base 

screen in the 9000’s. 

 

Also, the Load Screen feature will be converted automatically, and you do not need to edit it.  

 

Conversion table of Trend Graph 

GP-PRO/PBIII GP-Pro EX 

Channel settings of Trend Graph Settings after conversion 

Normal  Historical Trend Graph+ Sampling Settings 

Pen Recorder Historical Trend Graph+ Sampling Settings 

Block Display Data Block Display Graph 
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4. Compatibility of K Tag (Input Order) 

 

If K tags are used on the GP2000/77R/70 Series, the input order may be changed and converted 

depending on the contents set with GP-PRO/PBIII. 

 

Cases that the input order of K tags may be changed. 

Condition 1 When placing multiple K tags 

 
Condition 2 When setting the same trigger bit addresses for all 

 

Condition 3 When setting the same tag names for all 
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* When all of the above conditions meet, the input order may be changed and converted. 



 
 

K tags will be converted into [Data Displays] for the GP3000 series.  

If you input data when the trigger bit of the data display is ON, the input order of the data display 

is the order in which you have placed K tags with GP-PRO/PBIII before conversion. 

 

In case that the input order of the data display of the GP3000 series is different from that of the  

GP2000/77R/70 series after conversion, set the [Input Order] feature of the GP-Pro EX data 

display to input the data in the order as you like. 
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5. Compatibility of K Tag (Difference of Writing) 

 

With GP-PRO/PBIII, in case that the bit length of the write-to device address is 32 bits and the bit 

length of the [Display & Write Data Format] of a K tag is 16 bits, the data is written with 32-bit 

according to the write-to device address. On the other hand, with GP-Pro EX, the data is written 

with 16-bit which is according to the settings for [Display & Write Data Format]. 

Therefore, in case that the minus value or the value that cannot be expressed with 16-bit is 

written, the result after writing to the device address will be different between GP-PRO/PBIII and 

GP-Pro EX. 

 

e.g.) In case to write "-1" 

  

 

GP-PRO/PBIII 

 
 

GP-Pro EX 
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If the bit length of the write-to device address is 32 bits and the bit length of [Display & Write Data 

Format] of a K tag is 16 bits, please change to 32-bit with GP-Pro EX after conversion.



6.Compatibility of K Tag (Indirect Setting) 

 

If you set [Indirect]‘s [Device Type & Address] in the K Tag Settings, it may not operate properly 

after conversion. 2 words are used to specify addresses for GP-PRO/PBIII’s K Tag, but 4 words 

are used to specify addresses for GP-Pro EX’s Data Display in order to support multi-protocol 

(device multiple connection). For example, if you convert a project file with several K tags, which 

have [Device Type & Address] of [Indirect] settings, located by 2 words between each on, 

addresses specification will be duplicated. To operate them properly, please set the addresses 

not to duplicate. 
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Description of K Tag Setting 

* When [Indirect] is checked and [Device Type & Address] is selected on the [Data Format] tab 

  

  

 2 words are used to specify addresses for GP-PRO/PBIII’s K tag as below.  

 

 
4 words are used to specify addresses for GP-Pro EX’s Data Display as below. 

 



7. Compatibility of N Tag 

 

GP-PRO/PBIII’s N Tag is converted to GP-Pro EX’s Data Display.  

 

However, if you used [N699] of [N Tag] for input setting in the GP*10 series, it is converted to 

GP-Pro EX’s [Numeric Display] of Data Display (→ see NOTE). 

In this case, checking the Input Permit box in the [Data Display] setting window enables numeric 

input. 

 

NOTE 

Data of the GP*10 series (*.GPM) cannot be converted on GP-Pro EX. Convert it to data of 

GP-PRO/PBIII (*.prw) first, and then convert it to data of GP-Pro EX. 
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8. Precautions for using the switch for [History Data Display] of Trend Graph on the window 

 

GP-PRO/PBIII’s [Trend Graph] includes a feature of history display. GP-Pro EX is also able to 

display history data. However, if the following operation of history display was used in 

GP-PRO/PBIII, it may not operate properly after conversion.  

 

Example of usage of GP-PRO/PBIII’s Trend Graph 

The graph normally works as a trend 

graph. To display history data, it calls a 

window.  

 

The graph displays history data on a called 

window.  

The [Trend Operation Key] of the Special 

Switch, which operates the history data, 

operates on the window.  
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GP-Pro EX’s Historical Trend Graph after conversion 

The switches for [Historical Trend Graph], 

which are of Special Switch for history 

display, do not operate on the window.  

NOTE 

GP-PRO/PBIII enables the operation keys of history display on the window, on the other hand, 

GP-Pro EX doesn’t.  

Please place the operation keys on the screen directly.  
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Not Available! 



9. About the performance when a window is overlapping on a momentary switch  

Between GP-PRO/PBIII and GP-Pro EX, performance when a window is displayed overlapping 

on a momentary switch differs.  

The momentary switch’s basic performance is the same; a bit is on while the switch is touched 

and it is off when untouched. 

However, if a window appears on the area of the momentary switch that you are touching, 

GP-PRO/PBIII keeps the bit on while you are touching. On the other hand, GP-Pro EX turns off 

the bit in this situation.  

 

10. About the performance when display area of the system window is overlapping 

 

As a major example, the message banner feature of the Alarm part is one of the system 

windows. 

GP-PRO/PBIII allows switches, which are placed behind the message banner, to be activated 

even while an Alarm message is running. However, GP-Pro EX does not.  

To activate switches on the bottom of the screen even while an Alarm message is running, 

re-edit the screen not to overlap the message banner display area on the switches.  

 

The switch function overlapped by the error display or Japanese FEP, which is also a system 

window, is not activated as well.  

 

 

11. Change of Tag Process 

 

Between the GP3000 series and the GP2000/77R/70 series, screen-processing speed differs 

depending on the performance of the hardware.  

With the GP2000/77R/70 series, when D-script operates arranging the fine timing by using Tag 

Scan Time or Tag Scan Counter, after the project file conversion, it may not operate at the same 

timing with the GP3000 series. 
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For replacement to the GP3000 series, please carry an operation check or tuning of D-script. 



12. Compatibility of Text 

 

 

 

GP-PRO/PBIII’s [Direct Text] is converted to GP-Pro EX's [Direct Text].  

Basically, the operation of GP-Pro EX's [Direct Text] is the same as that of GP-PRO/PBIII's 

[Direct Text]. 

However, GP-Pro EX does not have selection setup items for GP-PRO/PBIII's [1/2 Kanji Font]. 

Instead of it, with GP-Pro EX, the Kanji size can be selected in 8 x 8. 

In converting data from GP-PRO/PBIII to GP-Pro EX, if the text size of [Direct Text] is set to Half 

Size, the text size setting after conversion differs in the following conditions. 

 

When the display of the text differs 

When double-byte and single-byte letters exist 

in one line 

→ Pattern 1 

When only single-byte letters exist in one line → Pattern 2 

 

Pattern 1: When double-byte and single-byte letters exist in one line 

Settings on GP-PRO/PBIII 

The font size is set to “1x1 (h)”.  

The half size (h) is available with single-byte letters, but not with 

double-byte letters.  

 

The right figure shows a Direct Text “ aaa”. 

“ ” is double-byte and “aaa” is single-byte and half sized.  

 

 

 
Text converted to GP-Pro EX  

The size will be changed to “8 x 16 dot”, therefore, the font size 

of “aaa” will be changed.   
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* This compatibility information applies only for using Japanese fonts.



 

Pattern 2 When only single-byte letters exist in one line 

Settings on GP-PRO/PBIII  

The font size is set to “1x1 (h)”. 

The half size (h) is available with single-byte letters, but not with 

double-byte letters.  

 

The right figure shows a Direct Text “ aaa”. 

“ ” is double-byte and “aaa” is single-byte and half sized. 

 

 

 
Text converted to GP-Pro EX  

The size will be changed to “8 x 8 dot” 

The font size of “  “ and “ ” will be smaller. 
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13. Compatibility of Fill 

 

GP-PRO/PBIII’s [Fill] setting is not supported by GP-Pro EX.   

If you have set [Fill] in GP-PRO/PBIII, [Square/Rectangle], [Polygon], etc. will be converted to a 

different Draw feature or a “Filled” object after converted to GP-Pro EX.  

However, in the following cases, there are differences of how to display between the GP2000 

series and the GP3000 series.  

 

 

Cases the Fill display differs 

When [Fill] is used with [Arc/Pie] → Pattern 1 

When an object after conversion includes more than 100 vertices → Pattern 2 

When [Fill] and [Load Screen] are used → Pattern 3 

When [Fill] is used with [Text] → Pattern 4 

 

Pattern 1: When [Fill] is used with [Arc/Pie] 

Before conversion (GP-PRO/PBIII) 

[Fill] is set in the [Arc/Pie] placed on the base 

screen. GP-PRO/PBIII fills the color with no 

space.  

 

 
After conversion (GP-Pro EX) 

GP-Pro EX displays as the figure on the right. 

Some space may be seen around the border. 
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Pattern 2: When an object after conversion includes more than 100 vertices 

Before conversion (GP-PRO/PBIII) 

[Fill] is used in a picture whose line’s angle is 

other than 45 degrees. (→ See the figure on the 

right.) The color of [Polyline] is set to white and 

[Fill] is to blue.  

 

Zooming up the picture, you can see the lines 

other than 45 degrees are out of alignment dot 

by dot. 

The points circled in red are counted as 

vertices. If there are more than 100 vertices, 

you need to note the followings.  
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After conversion (GP-Pro EX) 

It looks same as on GP-PRO/PBIII.  

 

[Fill] 

 

If you move the converted picture, you will see 

it has been converted into two objects; [Fill] 

and [Line/Polyline].  

[Line/Polyline] 

 



Please note that you cannot edit, or change 

size, on the [Fill] object. 

 
 

 

Pattern 3: When [Fill] and [Load Screen] are used 

Before conversion (GP-PRO/PBIII) 

The right figure B5 has only the [Fill] setting 

placed on it.  

 

 
 

A [Square] is placed on the center of the base 

screen B4, which calls B5 by the [Load Screen] 

feature.  
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After conversion (GP-Pro EX) 

The figure on the right is the base screen B4. 

 



You can see it is different from that of 

GP-PRO/PBIII.  

 

 

If you move the object a little, you will see the 

[Call Screen] and the [Rectangle] are 

separated.  

Screen display may differ.  
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Pattern 4: When [Fill] is used with [Text] 

Before conversion (GP-PRO/PBIII) 

[Fill] is used in a [Text].  

 

 
After conversion (GP-Pro EX) 

It looks same as that on GP-PRO/PBIII 

apparently.  

 

But the Fill has been converted to the Fill 

feature of [Polygon].  

 

  23/45 

 



14. Compatibility of CF Card Data 

 

The data format of a CF card differs between the former GP series and the GP3000 series.  

Please be aware of the following points when using a CF card, which you used with the former 

GP series, with the GP3000 series.  

 

Difference of file name 

Data that was created with GP-PRO/PBIII and available in a CF card can be basically used with 

GP-Pro EX. However, some data need to be converted. 

Data files in a CF card, which need to be converted, are sound data, image data, and filing data. 

You can use these data after converting them with the Project Converter and transferring to a CF 

card again.  

 GP-PRO/PBIII GP-Pro EX 

Image Screen Data ZI*****.BIN I*****.BIN 

Sound Data ZO*****.BIN O*****.BIN 

Filing Data ZF*****.BIN F*****.BIN 

 (*****; file number)   
 

Format of CF card 

The format type of the CF card for the GP2000/77R series is FAT16, and for GP3000 series is 

VFAT.  

VFAT is the successor of FAT16 and you can use the CF card for the former GP series even 

inserting into the GP3000 series without formatting. 

 Format Remark 

Former GP Series FAT16  

GP3000 Series VFAT VFAT is compatible with FAT16  
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15. Precautions for conversion when filing data is saved in a CF card 

 

If you used the GP-PRO/PBIII’s [Filing Data] feature and saved the filing data in a CF card, set 

the Data Type to [Project File (*.prw) ] before converting it to GP-Pro EX.  

If you select [CF Card Data], the filing data cannot be converted.  

 

The followings show an example of how to convert a project file with CF card data.  

 

Example of how to convert a project file with the Project Converter 

Select [Project File (*.prw)] for Data Type.  

 
 

Click [Browse…] in [Convert-From] and specify a GP-PRO/PBIII project file.  

  25/45 

 



 

Click [Browse…] in [Convert-To]. Enter the GP-Pro EX file name after conversion and click 

[Save].  

 
 

Click [Convert].  
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The confirmation window to ask if you change the data for CF card to that for GP-Pro EX will 

appear. Click [Yes].  

 

 

Specify the output destination of the CF card data for GP-Pro EX after conversion. If there is no 

file available, you can create a new folder by clicking the [Make New Folder] button.  

Converting a project file is completed. 
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16. Precautions for setting “Color Settings” to [256 Colors without blinking] 

 

GP-PRO/PBIII’s Color Settings for the TFT LCD screens in the GP2000 series are converted to 

GP-PRO EX’s [16384 Colors, 3-Speed Blink].  

If you set the color to [256 Colors without blinking] in GP-PRO/PBIII, the settings will be changed 

to [16384 Colors, 3-Speed Blink] after conversion. If you use the converted data on the GP3000 

series, the display may differ from before conversion or blink when setting the Color Type to 

“Indirect”. 

In order that GP-Pro EX displays the same as GP-PRO/PBIII displayed, set the number of colors 

(Color Settings) to [65535 Colors without blinking] before converting the screen data.  

The followings are a possible example that “Indirect” of the color type is set and explain how to 

change the settings with GP-Pro EX. 

 

Example cases to set the color type to indirect 

If you have set the Color Type of E Tag, g Tag, H Tag, Keypad Input Display or Draw function of 

D-Script to “Indirect”, please change the settings as follows.  

 

1. E Tag 2. g Tag 

 

When setting the Color Type of an E Tag to 

“Indirect”  

 

 

 

When setting the Color Type of a g Tag to 

“Indirect” 
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3. H Tag 4. Keypad Input Display 

 

 
 

 

 

 

When using Draw data address on an H Tag 

 

 
 

When setting the Color Type of a Keypad Input 

Display to “Indirect”  
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5. Address specification of the D-Script’s Draw function 

 

 
 

When changing the displayed color by assigning color data to an address with the D-Script’s 

Draw function  



 

How to change with GP-Pro EX 

With GP-Pro EX, change the color type to [65535 Colors No Blink]. 

You can change the setting by following [System Settings Window] -> [Main Unit Settings] -> 

[Display Settings] -> [Color Settings].  

 

Confirm if the [System Settings Window] is displayed. If not, select the [View] menu -> [Work 

Space] and click [System Settings Window]. The [System Settings Window] will appear in the left 

of the Editor.  

 

 

Click [Main Unit Settings] in the [System Settings Window].  
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Click , next to [16384 Colors, 3-Speed Blink] of Color Settings in the [Display Settings] area.  

 

 

Select [65535 Colors, No Blink]. 

 

The settings are completed.  

After transferring the screen data, performance will be the same as before.  
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17. Precautions for loading a part with “L Tag (Library Display)” 

 

If you call a part from another screen using GP-PRO/PBIII’s [L Tag (Library Display)], you can 

load the picture of the part even though the part’s features cannot be loaded.  

GP-Pro EX’s [Picture Display] is the alternative for [L Tag], however, if you call a [Picture Display] 

from another screen, even the picture will not be loaded.  

The followings explain how GP-PRO/PBIII displays.  

 

Example of settings on GP-PRO/PBIII  

An [L Tag] is placed on B1 and a [Lamp] part is placed on B1000.  

The part on B1000 is loaded to B1 using the L tag.  

B1 B1000 

 

An [L Tag] is placed on the center of the 

screen. 

A [Lamp] part is placed on the center of the 

screen.  

When setting as above, GP shows the picture of the Lamp part when the trigger bit of the L Tag 

turns on.  

GP screen when the bit is off GP screen when the bit is on 
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Only picture of the 

part will be loaded. 



GP-Pro EX’s performance and precautions 

Convert the data to GP-Pro EX. The picture of the Lamp will not appear even if you turn on the 

trigger bit of the [Picture Display], which is the part for an L Tag after conversion, without 

changing settings.  

 

To display it on GP-Pro EX, replace the Lamp part with a picture.  

This section introduces you how to import a bitmap data as a picture of a switch.  
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How to replace a part to a draw with GP-Pro EX 

Open the GP-Pro EX screen on which a part is 

placed.  

 
 

To make a bitmap file, copy it to any paint 

application by using the print screen feature of 

the PC. 

 

 

Cut the “Lamp” part from the image and save it 

as a bitmap file. (The data types that GP-Pro 

EX can load are as follows; *.bmp, *.jpeg, 

*.jpg, *.jpe, *.jfif, *.dpd)  

We recommend you to keep its size to the 

same as the part.  

 



Delete the part on GP-Pro EX and place the 

image file instead. To place the image data, 

select the [Draw] menu → [Image Placement]. 

Select the image data and click the [Open] 

button to upload the image data.   

 

 
Delete the “Lamp” part placed already on the 

screen and re-place the uploaded image on 

the position of the Lamp 

 

It looks the same as before. 
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Delete this. 

Lamp part 



18. Compatibility of MRK files and CPW files 

 

Library files (CPW files) and Mark Library files (MRK files) cannot be converted with the Project 

Converter directly.  

To use them by converting with GP-Pro EX, please follow the conversion procedures.  
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File Type How to Convert 

Library file 

(CPW file)  

Place a Library file to convert on the base screen of 

GP-PRO/PBIII and convert it with the Project Converter. 

Mark Library file 

(MRK file) 

Place a Mark Library file to convert on the mark screen of GP-

PRO/PBIII and convert it with the Project Converter. 



19. Compatibility of VM Unit Settings 

 

The GP3000 series supports only the Extend mode of Video Window Control (Standard 

mode/Extend mode) which each GP2000/77R/70 series supports. Each Settings of VM Unit will 

be converted as follows.  

 

 Before Conversion After Conversion  

System Settings Standard mode, 

Extend mode 

VM Unit Settings 

(Standard mode deleted) 

→ Details 

Base Screen V Tag, v Tag VM Unit Display (V Tag deleted) → Details 

Video Screen Video Screen VM Unit Window → Details 
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System Settings 

Only the Extend mode will be converted (Center Zoom and Display Mode will not be reflected as 

they are the functions related to the Standard mode). If Video Control Start Address is set to 

LS0000, it'll be set as [OFF], and if LS0020 or after, it'll be converted without change. 

 

 

 



Base Screen 

A small v Tag will be converted to a VM Unit Display of parts. The Setting contents will not be 

changed. In case that the Standard mode on System Settings is selected, even if you place a 

small v Tag, it will not be converted and will be displayed as an error message in the item of Text 

Output after conversion. 

If you save with ”Save Convert Information” which is displayed after operating project 

converter.... 

 

The error message as below will be output. 

 

 

Video Screen 

The Video Screen will be converted to VM Unit Window in Common Settings and T Tag on Video 

Screen will be converted to Video Switch. 

VM Unit Display will be converted before all of the switches, and if it is grouped, it’ll be out of the 

group. 
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20. Compatibility of Extended SIO Script 

 

GP-PRO/PBIII’s [Extended SIO Script] is converted to GP-Pro EX’s [Extended Script] in the 

[Script Settings].  

The contents of the [Extended SIO Script] are converted as they are. However, the Extended 

SIO Script’s assignment to COM ports may vary or may be cancelled after conversion depending 

on the configuration of the COM ports. 

Select your interface pattern set with GP-PRO/PBIII and refer to its conversion pattern.  

 

Interface setting pattern table when using the GP2000 series’ Extended SIO Script 

COM1 COM2 LAN Interface Conversion Pattern 

PLC *1 

 (RS-232C) 

Extended SIO Script 

(RS-232C) 

Unused Pattern 1 

PLC *1 

 (RS-422) 

Extended SIO Script 

(RS-232C) 

Unused Pattern 2 

Extended SIO Script 

(RS-422) 

PLC *1 

 (RS-232C) 

Unused Pattern 3 

Unused Extended SIO Script 

(RS-232C) 

PLC Pattern 4 

Extended SIO Script 

(RS-422) 

Unused PLC Pattern 5 

*1 indicates that a PLC type is selected. Temperature controllers, inverters are included.  

 

Reference: The interface, on the GP3000 series, compatible with RS-232C is COM1. If the 

Extended SIO Script cannot be assigned to the COM1 of RS-232C, the assignment is cancelled. 

For reference, the table of COM1 port of the GP series is shown below.  

 

 COM1 COM2 

GP3**0 Series RS-232C/485 (422) RS-485 (422) 

GP3302B RS-232C RS-485 (422) 

GP3200 Series RS-232C/485 (422) - 
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The GP3**0 series includes GP3750, GP3600, GP3500, GP3400, and GP3300. 



Conversion Pattern 

Pattern 1 

After conversion, the PLC type will be assigned to the COM1 port and the assignment of the 

Extended SIO Script will be canceled.  

GP-PRO/PBIII 

Interface COM1 COM2 LAN 

Communication type RS-232C RS-232C - 

Usage PLC protocol Extended SIO Script - 

 (- Unused/Unsupported) 

GP-Pro EX 

Interface COM1 COM2 LAN 

Communication type RS-232C RS-422/485 - 

Usage PLC protocol -(*2) - 

   

*2: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s 

[System Settings Window] → [Peripheral Settings] → [Script Settings]. For the RS-232C 

connection on the COM2 port, however, conversion of RS-232C/422 is required. For more 

information, contact the nearest Pro-face office.  
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Pattern 2 

After conversion, the PLC type will be assigned to the COM1 port and the assignment of the 

Extended SIO Script will be canceled. 

GP-PRO/PBIII 

Interface COM1 COM2 LAN 

Communication type RS-422 RS-232C - 

Usage PLC protocol Extended SIO Script - 

 
 



(- Unused/Unsupported) 

 

*3: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s 

[System Settings Window] → [Peripheral Settings] → [Script Settings]. For the RS-232C 

connection on the COM2 port, however, conversion of RS-232C/422 is required. For more 

information, contact the nearest Pro-face office. 

GP-Pro EX 

Interface COM1 COM2 LAN 

Communication type RS-422 RS-422/485 - 

Usage PLC protocol - (*3) - 

 

Pattern 3 

After conversion, the PLC type set to COM2 will be assigned to COM1 and the assignment of the 

Extended SIO Script will be canceled.  

GP-PRO/PBIII 

Interface COM1 COM2 LAN 

Communication type RS-422C RS-232C - 

Usage Extended SIO Script PLC protocol - 

 (- Unused/Unsupported) 

 

GP-Pro EX 

Interface COM1 COM2 LAN 

Communication type RS-232C - - 

Usage PLC protocol - (*4) - 

 

*4: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s 

[System Settings Window] → [Peripheral Settings] → [Script Settings]. Conversion on the COM2 

port of RS-232C422 is required. For more information, contact the nearest Pro-face office. 
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Pattern 5 

After conversion, the assignment of the [Extended SIO Script] will be cancelled. 

GP-PRO/PBIII 

Interface COM1 COM2 LAN 

Communication type RS-422C - 10BASE-T 

Usage Extended SIO Script - PLC protocol 

  (- Unused/Unsupported) 

GP-Pro EX 

Interface COM1 COM2 LAN 

Communication type - - 10BASE-T 

Usage - (*5) - PLC protocol 

 

*5: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s 

[System Settings Window] → [Peripheral Settings] → [Script Settings]. Rewiring is also required 

because the pinout of the COM1 is different. For more information, contact the nearest Pro-face 

office. 
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Pattern 4 

After conversion, the [Extended SIO Script] set in COM2 will be assigned to COM2. Any change 

of settings is unnecessary. 

GP-PRO/PBIII 

Interface COM1 COM2 LAN 

Communication type - RS-232C 10BASE-T 

Usage - Extended SIO Script PLC protocol 

  (- Unused/Unsupported) 

GP-Pro EX 

Interface COM1 COM2 LAN 

Communication type RS-232C - 10BASE-T 

Usage Extended SIO Script - PLC protocol  



21. Compatibility of Sound Data 

 

After converting the sound data via Project Converter, you can use it with the GP3000/ST3000 

series, which you used with the GP2000/77R series. However, the playback may sound 

differently from the data of the GP2000/77R series because the format of the data is different. 

For the differences, refer to the following table.  
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 GP-PRO/PBIII GP-Pro EX 

Sound source PCM PCM 

Bit length 16bit 16bit 

Frequency 11kHz 8kHz 

Playback Monaural Monaural 

 

Audio Type 

Data type WAV format WAV format 

Output destination \data \data 

File name ZO*****.BIN (*****; file number) O*****.BIN (*****; file number) 



22. Compatibility of Device Monitor 

 

As for the “YOKOGAWA FACTORY ACE 1:1 Communication”, if you have set the Device 

Monitor feature, the feature will be deleted when conversion.  

 
 

Word devices cannot be displayed in the binary, which is possible with the GP2000 series. 

Even though the Device Monitor feature has been set, the feature will be deleted when 

converting a project file if the Global Window is not set or its Window Access Mode is set to 

“Direct”.  

Confirm that the Global Window’s access mode is set to “Indirect” before conversion.  
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The Device Monitor feature is supported by GP-Pro EX Ver.2.00 or higher.  



23. Compatibility of J Tag and R Tag 

 

GP-PRO/PBIII’s J Tag and R Tag are converted to GP-Pro EX’s [Picture Display] part –[Move 

Display] feature. 

Basically, the operation of GP-Pro EX's [Picture Display] part is the same as that of 

GP-PRO/PBIII's J Tag and R Tag, however, they may differ depending on the contents set in 

GP-PRO/PBIII. 

 

Cases that J Tag and R Tag are not converted 

The case either one J Tag or R Tag is placed on the screen  Pattern 1 

The case multiple J Tags with the same Rail number are placed on the screen Pattern 2 

 

Pattern 1: The case either one J Tag or R Tag is placed on the screen 

 

Example case 1 

If there is only one J Tag on a base screen, it will not be converted. The same applies to R Tag.

GP-PRO/PBIII GP-Pro EX 

 

 

Example case 2 

If a J Tag with the Rail number 1 and an R Tag with the Rail number 0, of its display positions 

specified, are on a base screen, they will not be converted.  

GP-PRO/PBIII GP-Pro EX 
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Pattern 2: The case multiple J Tags with the same Rail number are placed on the screen 

If there are two or more J Tags with the same Rail number, the tag that has the smallest JIS code 

will be converted. Other J Tags will not be converted.  

Example case 

Place 2 J Tags with the Rail number 1 on a base screen. On the screen, the following tags have 

been placed.  

Tag 
Tag 

name 
Address

Rail 

number
Convertible 

J_0000 D0 1 Yes J Tag 

J_0001 D100 1 No 

R Tag R_0000 - 1 Yes 

If you have set as above, “J_0000” and “R_0000” will be converted into one part.  

GP-PRO/PBIII GP-Pro EX 

The following is the settings of the [Picture Display] after conversion to GP-Pro EX.  

GP-Pro EX 
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